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TOUCHDOWN PLATEN KIT INSTRUCTIONS 

INTRODUCTION 
 

As Brother® GT-541® and GT-782® users become more familiar with their GT Printers, the need will grow 

to be able to print on more locations than the front and back of a garment.  That is where the 

Touchdown Platen Kit comes in.  This aftermarket platen kit works using the same four pin platen setup 

as the GT-541® and GT-782® printers.   With the twelve standard platen setups offered with the 

Touchdown Platen Complete Kit, GT users will be able to quickly switch from printing on short sleeves, 

long sleeves, hoodies with zippers, baby garments and other items. 

The following PDF file contains all the information on how to install, setup the artwork and print using 

the different platen inserts.  Please refer to these instructions when using the Touchdown Platen Kit. 

The Touchdown Platen Complete Kit contains the following items:   

1) Mounting Plate & Pins*  

2) T-Base Fixture* 

3) Youth Platen Insert (10.5” x 12.75”)* 

4) Baby Platen Insert (6.5” x 7.25”)* 

5) Two Square Platen Inserts (4.5” x 4.5”)  

6) Large Rectangle Platen Insert (3.5” x 8.5”) 

7) Small Rectangle Platen Insert (2.5” x 7.0”) 

8) Collar Platen Insert (4.5” x 2.25”) 

9) Long Sleeve Platen Insert (3.75” x 12.5”) 

10) Two Zipper Platen Inserts (6.0” x 16.0”) 

11) Small Polo Platen Insert (2.0” x 6.0”) 

12) Large Polo Platen Insert (2.0” x 10”) 

13) Platen Accessory Kit (Wing Nuts, Under-

Mount Bolts & Zipper Platen Bolts)*

* The Touchdown Platen Basic Kit contains only these items. 
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UNPACKING THE TOUCHDOWN PLATEN       (Click here for Video) 
 

The Touchdown Kit comes packed in a 16” x 16” x 4” size box that has four layers of packing foam.  With 

the Basic Kit, the top two layers are there to protect the pins on the Mounting Plate.  The top two layers 

of foam on the Complete Kit contain all the additional platen inserts not offered with the Basic Kit.   

To unpack the Touchdown Kit, carefully use a box cutter to cut the open the top of the box.  Do not cut 

too deep into the top of the box or you may scratch the top of some platen inserts.   

Open the box.  You will see the Zipper Platen Inserts and the Polo Platen Inserts.  Carefully remove the 

top layer of foam. 

 

You will now see the two Square Platen Inserts, Large Rectangle Platen Insert, Small Rectangle Platen 

Insert, Collar Platen Insert, two Undermount Platen Inserts and the Long Sleeve Platen Insert.  Carefully 

remove this layer of foam. 

 

Next, you will see the third layer of foam.  This layer of foam covers the remaining pieces of Touchdown 

Kit.  Carefully remove this layer of foam. 

http://youtu.be/CW9xDdCtVMI
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The final layer of foam holds the T-Base, Mounting Plate, Youth Platen Insert and Baby Platen Insert.   

 

Remove the T-Base and Mounting Plate. 

 

Remove the Baby Platen Insert and the Youth Platen Inserts.  Remove all the other platen inserts from 

the foam layers and place the foam layers back into the packing box.    
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DOWNLOADING THE PLATEN TEMPLATES 
 

When printing with the Touchdown Platen and all the different platen inserts, you will always print using 

the Adult Platen setting in the Brother® GT driver.  In order to know where to place the artwork in the 

correct location to match up with the platen insert being used, we recommend that you use one of the 

Touchdown Platen Templates.  These templates are layered PSD, CDR and PNG files that allow you to 

see exactly where your artwork needs to go.  The PSD and CDR files contain layers for each platen insert 

and a layer where you can import your artwork into.  By doing it this way, only the visible part of the 

artwork on your monitor will print out. 

You can download these templates from clicking on the link below: 

Download the Touchdown Platen Templates 

You will need to complete the fields for your name and email address before clicking the submit button. 

 

Check your email (and or Spam Inbox if necessary) for an email from GarmentTools.com.  In the email, 

there will be a unique hyperlink that will allow you to download the template files.  Click on the 

hyperlink. 

 

http://www.touchdownplaten.com/instructions.html
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A new internet browser window will open up and you will want to click on the download button to 

download the Touchdown Platen Artwork Templates.  Save this ZIP file to your desktop of your 

company. 

 

After you have downloaded the ZIP file, double click on the file and unzip the contents to a folder on 

your desktop.  Open this new folder on your desktop and you will see the different sub folder for the 

artwork templates. 
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USING THE PHOTOSHOP PSD PLATEN TEMPLATE 
 

After you have unzipped the artwork template folder, you will want to double click on the TD PSD 

Template files folder.  You will now see the following file: 

 

Double click on the file to open it up in either Adobe® Photoshop® or Adobe® Photoshop Elements® that 

you are working with.  

NOTE: Photoshop® may request whether you want to use one of three different color management 

options: 1) Leave as is, 2) Assign working RGB: sRGB or 3) Assign Profile.  You will want to use the 

assigned working profile option since the Brother® GT print drivers are designed to work with artwork in 

the sRGB working space color model. 

 

The artwork templates will show up in a layered file.  If you layers window is not visible, click on Window 

menu at the top and select Layers.  This will open the Layers window. 
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You will now be able to see all the layers for the different platen inserts.  By clicking on the eyeball next 

to a specific layer, you can turn on and off that layer.  You will also see the layer labeled “Your Artwork 

Here!”.  This is the bottom layer and where you want your artwork placed into or below this layer. 

 

Select the layer for the platen insert you are using by clicking on the eyeball next to it to make that layer 

visible.  Make sure all the other layers do not have the eyeball visible.  If they are visible, click on the 

eyeball to turn them off. 

 

Next, select the layer labeled “Your Artwork Here!” and click on the eyeball to make the layer visible.   
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Open your artwork file in a smaller window in Photoshop®.  Using the Move Tool ( ), left click and 

hold down on the left mouse button on the artwork file and drag-drop it into the template file.   

You will now see where a new layer has been created for the artwork that you just dropped in the 

template file.  Move the layer below the Your Artwork Here! layer by left clicking and holding it down as 

you drag the file down. 

 

Now in the artwork template file using the Move Tool, select the layer your artwork is in and move it 

into the correct place so the design is visible. 

 

If you need to readjust the size of your design, click on the Edit Menu  choose the Transform option 

and select Scale. 
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Using the corner nodes, adjust the size of the artwork to by holding down the Shift button and dragging 

the corner nodes till you have the correct side for the template you are using.  Press the Enter button to 

save the changes. 

 

If you are using a template that contains multiple platen inserts, you will need to duplicate the artwork.  

You can repeat the steps above or you can drag the artwork file in the Layers window down to the 

Create a New Layer icon.  This will create a new layer of the same exact size of artwork.  You can then 

use the Move Tool to position it in the correct place. 
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You are now ready to print the artwork using the Brother® GT print driver.  You will want to use the 14” 

x 16” Platen option is the GT print driver. 
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USING THE CORELDRAW (CDR) PLATEN TEMPLATE 
 

After you have unzipped the artwork template folder, you will want to double click on the Photoshop® 

folder.  You will now see the following files: 

 Touchdown Templates Corel10.cdr 

 Touchdown Templates CorelX3.cdr 

 Touchdown Templates CorelX5.cdr 

 

Double click on the file that will work with the version of CorelDraw that you are working with.   The file 

will open up in your graphic software program.   Because CorelDraw does not use the same 

transparency fill that other graphic software programs use, you may not see anything initial.  Don’t 

worry, the layers are there! 

The artwork template will show up in a layered file.  If you layers window is not visible, click on Tools 

menu at the top and select Object Manager.   

  

This will open the Object Manager window and allow you to see all the layers. 
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Select the layer for the platen insert you are using by clicking on the eyeball next to it to make that layer 

visible.  Make sure all the other layers do not have the eyeball visible.  If they are visible, click on the 

eyeball to turn them off. 

 

Next, select the layer labeled “Your Artwork Here!” and click on the eyeball to make the layer visible.   

 

Click on the File menu at the top and select the Import option.   

 

 

Select the artwork file on your computer and click the Import button. 
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You will see some information about the file.  If you double left click, the artwork will be imported in the 

Your Artwork Here! layer in its original size. 

 

Now drag the platen insert template that you are using in the Object Manager and drop it below the 

Your Artwork Here! layer.  This will allow you to adjust the artwork without moving the template. 

 

Now you can adjust the size and location of the artwork file by click on the corner nodes and holding the 

Shift button down as you resize the artwork.  Click on the center of the artwork to move it into the 

proper location. 
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If you are using a template that contains multiple platen inserts, you will need to duplicate the artwork.  

You can repeat the steps above or copy & paste the artwork using the Edit Menu options .  To do this, 

click on the artwork, select the Edit menu button and choose the Copy option. 

 

Then select the Edit menu button and choose the Paste Option. 

 

Then select the duplicated piece of artwork and drag it to the location desired in the template. 

 

Now drag the platen insert template that you are using in the Object Manager and drop it above the 

Your Artwork Here! layer.  This will allow you to adjust the artwork without moving the template. 
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You are now ready to print the artwork using the Brother® GT print driver.  You will want to use the 14” 

x 16” Platen option is the GT print driver. 
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USING THE PNG PLATEN TEMPLATE 
 

For those GT Users that don’t want to use the PSD or CDR template files, we have included separate 

PNG files that have a transparency in them.  To use these PNG files, you will need to have a graphic 

software program that allows for layers.  The zip file of the platen templates contains a folder labeled 

PNG.  Inside that folder, you will see the following files. 

 

Open the PNG template file inside the graphic software program.  Make sure you make a new layer to 

import the artwork file into it. 

 

Then import your artwork in the new layer.  Adjust the size and location of the artwork to fit inside the 

platen template. 
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If you are using a template that has multiple platen inserts, you will need to duplicate the artwork in 

your graphic software program and position it into the correct location. 

 

You are now ready to print the artwork using the Brother® GT print driver.  You will want to use the 14” 

x 16” Platen option is the GT print driver. 
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SETTING UP THE T-BASE FIXTURE        (Click here for Video) 
 

To install the T-Base fixture, you will first need to remove the platen that is currently on the GT printer.  

To do this, loosen the Platen Fixing Lever by turning it counter-clockwise.  Then lift the platen off using 

two hands. 

   

The T-Base fixture will have the Mounting Plate and Pins already assembled to it.  For GT users that have 

the Complete Kit, the Undermount Platen Inserts will need to be assembled to the T-Base.  Locate the 

Undermount Platen Inserts and the short bolts used to secure them to the T-Base.  Using a 4 mm allen 

wrench, secure the two Undermount Platen Inserts to the T-Base. 

   

Then flip the T-Base over and insert it on to the Brother® GT platen system just like you would do with a 

standard GT platen.   

 
Once you secure the platen insert to the T-Base and loaded the garment on it, you will want to adjust 

the height of it using the GT Platen Height Adjustment Lever. 

http://youtu.be/-xl_GNckAeA
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WORKING WITH THE YOUTH PLATEN INSERT   (Click here for Video) 
 

To install the Youth Platen Insert, you will want to place the threaded screw in the front left hole (closest 

to you at the bottom of the T-Base) and the two straight screws in the third hole from back on each side. 

 

Then using the included wing nuts, tighten one wing nut from the bottom of the T-Base on the threaded 

screw to keep the platen firmly in place. 

Then use the artwork template for your graphic software program, select the Youth Platen layer as 

shown below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver.  

Straight Pin Straight Pin 

Threaded Pin 

Place artwork in the 

checkerboard area. 

http://youtu.be/GcjfAtsE9YU
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WORKING WITH THE BABY PLATEN INSERT    (Click here for Video) 
 

To install the Baby Platen Insert, you will want to place the threaded screw in the second left hole 

(closest to you at the bottom of the T-Base) and the straight screw in the second right hole from the 

bottom of the T-Base. 

 

Then using the included wing nuts, tighten one wing nut from the bottom of the T-Base on the threaded 

screw to keep the platen firmly in place. 

Then use the artwork template for your graphic software program, select the Baby Platen layer as 

shown below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver. 

  

Straight Pin Threaded Pin 

Place artwork in the 

checkerboard area. 

http://youtu.be/dg1RKt5cPHg
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WORKING WITH A SINGLE SQUARE PLATEN INSERT    (Click here for Video) 

 

To install a single Square Platen Insert, you will want to place the threaded screw in the first left hole 

(closest to you at the bottom of the T-Base) and the straight screw in the first right hole from the 

bottom of the T-Base. 

 

Then using the included wing nuts, tighten one wing nut from the bottom of the T-Base on the threaded 

screw to keep the platen firmly in place. 

Then use the artwork template for your graphic software program, select the Square 1 layer as shown 

below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver.  

Straight Pin Threaded Pin 

Place artwork in the 

checkerboard area. 

http://youtu.be/1o14vtk_VR0
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WORKING WITH TWO SQUARE PLATEN INSERT     (Click here for Video) 

 

To install both Square Platen Inserts, you will use the sides of the T-Base to spread the platen inserts out 

to allow for additional space for the garments.  You will place the threaded screw in the first left hole on 

the side of the T-Base and the straight screw in the third hole on the side of the T-Base for each platen 

insert. 

 

Then using the included wing nuts, tighten one wing nut for each Square Platen Insert from the bottom 

of the T-Base on the threaded screw to keep the platens firmly in place. 

Then use the artwork template for your graphic software program, select the Squares 2 layer as shown 

below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver.  

Threaded Pin Threaded Pin 

Straight Pin Straight Pin 

Place artwork in the 

checkerboard area. 

Place artwork in the 

checkerboard area. 

http://youtu.be/1o14vtk_VR0
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WORKING WITH LARGE RECTANGLE PLATEN INSERT      (Click here for Video) 

 

To install the Large Platen Insert, you will use one of the sides of the T-Base.  You will place the threaded 

screw in the first hole on the side of the T-Base and the straight screw in the second hole on the outside 

of the T-Base. 

Large Rectangle (Left Side)                                      Large Rectangle (Right Side) 

      

Then using the included wing nuts, tighten one wing nut from the bottom of the T-Base on the threaded 

screw to keep the platen firmly in place. 

Then use the artwork template for your graphic software program, select the Large Rectangle (Left) or 

Large Rectangle (Right) layer as shown below.  Remember that the GT print driver flips the artwork 

when you print it.  So what looks on the monitor is 180 degrees different on the printer. 

Large Rectangle (Left)                                              Large Rectangle (Right) 

                             

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver. 

 

Threaded Pin Threaded Pin 

Straight Pin Straight Pin 

Place artwork in the 

checkerboard area. 

Place artwork in the 

checkerboard area. 

http://youtu.be/odz_GYOI-TA
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WORKING WITH SMALL RECTANGLE PLATEN INSERT       (Click here for Video) 

 

To install the Small Platen Insert, you will use one of the sides of the T-Base.  You will place the threaded 

screw and corresponding straight pin in the first set of holes on the side of the T-Base and the straight 

pins in the second set of holes on the outside of the T-Base. 

Small Rectangle (Left Side)                       Small Rectangle (Right Side) 

      

Then using the included wing nuts, tighten one wing nut from the bottom of the T-Base on the threaded 

screw to keep the platen firmly in place. 

Then use the artwork template for your graphic software program, select the Small Rectangle (Left) or 

Small Rectangle (Right) layer as shown below.  Remember that the GT print driver flips the artwork 

when you print it.  So what looks on the monitor is 180 degrees different on the GT printer. 

Large Rectangle (Left)                                              Large Rectangle (Right) 

                             

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver. 

  

Threaded & 

Straight Pins 

Threaded & 

Straight Pins 

Straight Pins Straight Pins 

Place artwork in the 

checkerboard area. 

Place artwork in the 

checkerboard area. 

http://youtu.be/3jMp_SMsUp4
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WORKING WITH THE COLLAR PLATEN INSERT      (Click here for Video) 

 

To install the Collar Platen Insert, you will want to place the threaded screw in the first left hole (closest 

to you at the bottom of the T-Base) and the straight screw in the first right hole from the bottom of the 

T-Base. 

 

Then using the included wing nuts, tighten one wing nut from the bottom of the T-Base on the threaded 

screw to keep the platen firmly in place. 

Then use the artwork template for your graphic software program, select the Collar layer as shown 

below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver.  

Straight Pin Threaded Pin 

Place artwork in the 

checkerboard area. 

http://youtu.be/O6laQ72RC9k
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WORKING WITH THE LONG SLEEVE PLATEN INSERT     (Click here for Video) 

 

To install the Long Sleeve Platen Insert, you will need to have the Undermount Platen Inserts installed.  

These platen inserts are affixed to the bottom side of the T-Base fixture using the short bolts.  The bolts 

are attached to the center holes at the top and bottom of the T-Base.  Then the want to place the 

threaded screw in the first left hole (closest to you at the bottom of the T-Base) and the straight screw in 

the first right hole from the bottom of the T-Base. 

Undermount Platen Inserts          Long Sleeve Platen Insert          Completed Long Sleeve Platen 

            

Using the included wing nuts, tighten one wing nut from the bottom of the T-Base on the threaded 

screw to keep the platen firmly in place.  Load the long sleeve over the top of the Long Sleeve Platen 

Insert and use rubber bands to secure both ends of the long sleeve to the Undermount Platen Inserts. 

Then use the artwork template for your graphic software program, select the Long Sleeve layer as 

shown below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver.  

Short Bolt Straight Pin  

Short Bolt 

Straight Pin  

Threaded Pin 

Straight Pin  

Place artwork in the 

checkerboard area. 

http://youtu.be/fOoYxb13Y7U
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WORKING WITH THE ZIPPER PLATEN INSERTS      (Click here for Video) 

 

To install the Zipper Platen Inserts, you will use the Long Bolts that were included with the Complete 

Touchdown Kit.  Place both Zipper Platen Inserts on each side of the T-Base fixture.  Insert the Long Bolt 

through the bottom slots and the first hole on each side of the bottom of the T-Base before screwing on 

a wing nut for each piece.  Then insert a Long Bolt through the middle slots and through the second set 

of holes on the sides of the T-Base fixture before attaching wing nuts to each bolt.  The slots allow you 

to adjust the width of the center channel to different sizes depending on the garment features you are 

printing on (i.e. zipper, buttons,…).    

              Long Bolt Insert Holes                    Small Center Channel                         Large Center Channel 

 

Tighten the wing nuts to prevent the Zipper Platen inserts from moving. 

Then use the artwork template for your graphic software program, select the Long Sleeve layer as 

shown below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver.  

Long Bolts 

Place artwork in the 

checkerboard area. 

Place artwork in the 

checkerboard area. 

http://youtu.be/2FoOs6EZ6Po
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WORKING WITH THE POLO PLATEN INSERTS        (Click here for Video) 

 

To install either of the Polo Platen Inserts, you will need to have the Zipper Platen Inserts already 

mounted on the T-Base fixture.  Then you will just need to drop in the appropriate Polo Insert you desire 

in between the two Zipper Platen Inserts.  The tabs on the sides of the Polo Inserts will keep it in place 

when loading and unloading a garment.   

Small & Large Polo Inserts            Small Polo Platen Insert                Large Polo Platen Inserts 

                                                          

Then use the artwork template for your graphic software program, select either the Large Polo or Small 

Polo layer as shown below. 

          

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver.  

 

Place artwork in the 

checkerboard area. 

Place artwork in the 

checkerboard area. 

http://youtu.be/XB_7jM-_zx4
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NOTE:  You can put both of the Polo Platen Inserts between the Zipper Platen Inserts at the same time 

to form a complete 14” x 16” platen. 
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WORKING WITH THE WRAP AROUND PLATEN INSERT   
 

The Wrap Around Platen Insert is a specialty platen that is designed to print on part of the front of the 

shirt, around the side and on part of the back of the shirt.  This platen insert is sold separately from the 

Touchdown Platen Complete Kit, but uses some of the same components.  To install the Wrap Around 

Platen Insert, remove the four bolts that secure the T-Base fixture to the Mounting Plate.  Using the 

same four bolts, secure the Wrap Around Platen Insert to the Mounting Plate. 

                  T-Base Fixture                          Mounting Plate                     Wrap Around Platen Insert 

                                                                                                              

Then using the artwork template for your graphic software program, select Wrap Around layer as shown 

below. 

 

Once the artwork is positioned on the template file correctly, print using the 14” x 16” platen size in the 

Brother® GT driver. 

 

 

Place artwork in the 

checkerboard area. 
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FREQUENTLY ASKED QUESTIONS 
 

Below is a list of questions that are frequently asked about the Touchdown Platen Kit. 

Q:  What is the T-Base fixture made out of?   

A:  It is made out of .22 solid aluminum that is laser cut to specific measurements and then powder 

coated black. 

Q:  What are the platen inserts made out of? 

A:  The platen inserts are made out of .2 thickness polycarbonate material.  We choose to use the 

polycarbonate material instead of acrylic because it is substantially stronger and less likely to break. 

Q:  What size are the wing nuts and bolts in case I lose them? 

A:  The nylon wing nuts are .4 mm size and should be found at most hardware stores.  The four bolts 

used to connect the T-Base to the Mounting Plate are ¼” – 28 thread x ½” long with a 5/32 hex to 

tighten or remove.  The four long bolts used with the Zipper Platen Inserts are M4 – 7mm thread x 20 

mm long with a 3 hex to tighten or remove. 

Q:  I purchased a Basic Kit and would like to get one or more of the extra platen inserts that come with 

the Complete Kit.  Can I purchase them now? 

A:  Yes you can.  Contact the Brother distributor that sold you the Basic Kit and ask them for more 

details. 

Q:  Do I need any tools to assembly the Touchdown Platen? 

A:  The T-Base comes already assembled to the Mounting Plate and Pins.  You will need a 5/32 allen 

wrench to install the Undermount Platen Inserts to the T-Base.  If you plan on purchasing the Wrap 

Around Platen Insert, you will need to remove the four ¼” – 28 thread x ½” long with a 5/32 hex to 

tighten or remove bolts that connect the T-Base fixture to the Mounting Plate.  Other than that, all the 

other components can be attached or removed with using just your fingers. 

Q:  If the T-Base or any of the platen inserts are not level the bottom of my print heads, what do I do? 

A:  There are four (4) thin wall inserts on the bottom of the T-Base that allow you to level the T-Base to 

the bottom of the print heads.  To adjust the thin wall inserts, slightly loosen the four bolts connecting 

the T-Base to the Mounting Plate.  Flip the T-Base over and use a wide flat-head screwdriver to rotate 

one of the thin wall insert to adjust the T-Base.  The thin wall insert will touch the T-Base on the bottom 

side and allow you to make minor adjustments.  Adjust one thin wall insert at a time and then check to 

see if the platen is level.  Once it is level, hand tighten the four bolts that secure the T-Base to the 

Mounting Plate. 

Q:  Does the platen inserts come with the platen fabric on them? 

A:  No, the platen inserts do not come with the platen fabric that is provided on the GT platens.  You can 

purchase the platen fabric from your Brother® authorized distributor and cut them down to size if you 

want.  You can also use double-sided carpet tape for the smaller platens that you would like assistance 

in holding the fabric or part of the garment in place. 
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Q:  With the Long Sleeve Platen Insert, is it possible to thread the long sleeve on to the platen insert? 

A:  No, the Long Sleeve Platen Insert is designed to lay both sides of the garment on top of the platen 

insert.  You cannot thread the long sleeve on to the platen insert because the pins used to secure and 

adjust the height of the platen are in the center of the T-Base and will prevent the long sleeve from 

sliding all the way on. 

Q:  What can I use to clean my platen inserts if ink gets on them? 

A:  You a mild mixture of soap and water on a soft towel to clean the platen inserts.  Do not use any type 

of abrasive cleaners, abrasive pads or scraping tools.  When cleaning them, hold the platen inserts by 

the sides and not by the pins as you could widening the taped holes that are holding the pins. 

Q:  Is the Touchdown Platen heavier than the GT platens? 

A:  The Touchdown Platen with the most amount of platen inserts on it weighs slightly heavier than the 

Adult 14” x 16” platen and weighs less than the Oversized 16” x 18”platen.  So the weight of the 

Touchdown Platen is within the acceptable range of other platens made by Brother®. 

Q:  Do you have to do any type of modification to the Brother® GT printer that may affect the warranty 

of the printer? 

A:  No, there is no modification to the Brother® GT printers when using the Touchdown Platen.  Thus, 

your warranty should not be affected. 

Q:  Where can I get custom platen inserts made to my specifications? 

A:  Contact the Brother distributor that you purchased the Touchdown Platen Kit from about getting 

custom platens made.  Because the platen inserts are custom, the price is typically higher because they 

are not made in higher quantities. 

Q:  Can I use the T-Base fixture and create my own custom platens to my specifications? 

A:  Sure you can.  You will want to make sure that you are using a flat piece of material that does not 

weigh any more than the two Zipper Platen Inserts. 


